
 
 

 
 
 
 
 
 
 
 
 

MAP-122 Adjustment 
System 

 
 
 
 

User Manual 
Version 1.1 

 
 
 
 
 

 
 
 
 

 
For internal use by the Department of Medical Assistance Services (DMAS) 

 
January 2000



MAP-122 Adjustment System User Manual  Table of Contents 

 
Table of Contents 

 

CHAPTER 1:  THE BASICS ................................................................................................................... 1-1 

INTRODUCTION TO THE MAP-122 ADJUSTMENT SYSTEM ........................................................................ 1-2 
HOW TO USE THIS MANUAL ..................................................................................................................... 1-2 
USER ROLES ............................................................................................................................................. 1-2 

Manager .............................................................................................................................................. 1-2 
Administrator ....................................................................................................................................... 1-2 

MANUAL CONVENTIONS .......................................................................................................................... 1-2 
THE MAIN INTERFACE .............................................................................................................................. 1-3 
ORACLE SOFTWARE FEATURES YOU NEED TO KNOW .............................................................................. 1-3 

Message/Status Bar ............................................................................................................................. 1-3 
Lists of Values ..................................................................................................................................... 1-4 

NAVIGATION ............................................................................................................................................ 1-5 
HELPFUL HINTS ........................................................................................................................................ 1-5 
LOGGING ON ............................................................................................................................................ 1-5 

CHAPTER 2:  PRIMARY TASKS .......................................................................................................... 2-1 

ENTERING A NEW ADJUSTMENT REQUEST ............................................................................................... 2-2 
Entering a New Adjustment Request for a CBC Recipient .................................................................. 2-2 
Entering a New Adjustment Request for a Recipient Who Lives in a Facility ..................................... 2-5 

UPDATING AN ADJUSTMENT REQUEST ..................................................................................................... 2-8 
Updating a CBC Adjustment Request .................................................................................................. 2-8 
Updating an Adjustment Request for a Recipient Who Lives in a Facility .......................................... 2-8 

REVISING A PENDING ADJUSTMENT REQUEST ......................................................................................... 2-9 
Revising a Pending CBC Adjustment Request ..................................................................................... 2-9 
Revising a Pending Adjustment Request for a Recipient Who Lives in a Facility ............................... 2-9 

GENERATING AND PRINTING LETTERS ................................................................................................... 2-11 
GENERATING AND PRINTING ENVELOPES ............................................................................................... 2-14 

CHAPTER 3:  SECONDARY TASKS .................................................................................................... 3-1 

PERFORMING QUERIES ............................................................................................................................. 3-2 
GENERATING AND PRINTING REPORTS ..................................................................................................... 3-7 

Monthly Reports .................................................................................................................................. 3-7 
Annual Reports .................................................................................................................................... 3-8 

CHAPTER 4:  ADMINISTRATIVE TASKS ......................................................................................... 4-1 

ADDING REASON CODES .......................................................................................................................... 4-2 
ADDING FACILITY INFORMATION ............................................................................................................. 4-3 
UPDATING FACILITY INFORMATION ......................................................................................................... 4-3 
ADDING DSS INFORMATION .................................................................................................................... 4-4 
UPDATING DSS INFORMATION ................................................................................................................. 4-4 

APPENDIX:  MENUS & MENU OPTIONS ......................................................................................... A-1 

 ii 



MAP-122 Adjustment System User Manual  Chapter 1:  The Basics 

Chapter 1:  The Basics 
 
This chapter covers basic information that will help you use both this manual and the MAP-122 
Adjustment system effectively.  
 
This chapter includes the following topics: 
 

Introduction to the MAP-122 Adjustment 
 
How to Use this Manual 
 
User Roles 
 
Manual Conventions 
 
The Main Interface 
 
Oracle Software Features You Need to Know  
 
Navigation 
 
Helpful Hints 
 
Logging On 
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Introduction to the MAP-122 Adjustment System 
 
The MAP-122 Adjustment is a paper form used for requesting that a Medicaid patient's income be reduced 
by the amount of the patient's income, less certain deductions (patient pay amount).  One required 
deduction is an amount "for medical or remedial care not subject to payment by a third party."  This 
includes necessary medical or remedial care not covered under the Virginia State Plan for the Department 
of Medical Assistance Services.  Medicaid uses the patient pay amount to determine the amount of the 
facility's monthly billing that the patient will pay.  Patient pay plus Medicaid contribution equals the 
amount due the facility for the patient's care for that month. 
 
The MAP-122 Adjustment paper form evolved into the MAP-122 Adjustment system with the capabilities 
of information technology. Appropriately, the software took on the name of the form that preceded it.  

How to Use this Manual 
This manual is task-oriented because your job is task-oriented. Use the table of contents to find the task you 
want to complete, and turn to the corresponding page of the manual. 
 
. NOTE: This manual assumes that you have used a standard Windows application in the past 
and does not explain such standard things as mouse-clicks, scroll bars, or how to use Print dialog 
boxes. 

User Roles 
User roles determine the kinds of actions (i.e., viewing, adding, updating, deleting) a user can perform in 
the MAP-122 Adjustment system. The following names the user roles and describes their corresponding 
permissions. Consult your supervisor to find out your user role assignment.  
 
Manager 
Managers can view, add, update, and delete records anywhere in the MAP-122 Adjustment system. 
 
Administrator  
Administrators can view, add, update, and delete records anywhere in the MAP-122 Adjustment system 
except on the Facility and DSS forms (under the Maintenance menu). Administrators can only view facility 
and DSS records. 

Manual Conventions 
 Bullet points at the left margin mark the steps for completing a task. 
 
 Bold text within bulleted items indicates keyboard keys (e.g., Type the date and press Enter).  
 
 Quotation marks indicate field names (e.g., Put the cursor in the “Last Name” field). 
 
 The terms Recipient and Adjustment have initial capitals when they are used to indicate “generic” 

instances of Medicaid recipients and requests for financial adjustments.  
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The Main Interface 
The Main Interface (see Figure 1-1 below) of the MAP-122 Adjustment system is the screen that appears 
after you log in. It provides access to the main screen of the application.  
 

Figure 1-1. The Main Interface Screen. 

Oracle Software Features You Need to Know  
 
The MAP-122 Adjustment system is a product of Oracle software development tools. 
 
Oracle software includes some less-than-obvious functionality that you will need to know in order to use 
the software effectively. The following subsections explain what these features are and how to use them. 
 
Message/Status Bar 
 
The gray bar that runs across the bottom of your screen provides message and status information that is 
relevant to current processing activity in the MAP-122 Adjustment system. When you are in Query Mode, 
for example, the Message/Status Bar shows “ENTER QUERY”. When you have performed a query and 
begun to scroll through any returned records, the Message/Status Bar tells you what record you are on in 
the list.  
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Status information pertains to the progress of behind-the-scenes operations. For example, you will see 
“Working…” on the Message/Status Bar when the database is processing a query. The Message/Status Bar 
also displays Oracle error messages that may help you identify or understand any problems that arise.  
 
Figure 1-2 below displays the Message/Status Bar. Note that the message/status information shown is an 
example and is not intended to reflect what you will see on your Message/Status Bar at any given time.  

 Figure 1-2. Message/Status Bar. 
 
Lists of Values  
 
Oracle provides lists of values for fields whose possible entries are stored in the database. Lists of values 
provide convenience by allowing you to choose an option from a list instead of typing it. 
 
Fields that have lists of values associated with them cause “<List>” to display in the Message Bar (see 
Figure 1-2 above) when the cursor is in them. (If your cursor is in a given field and you do not see “<List>” 
in the Message Bar, then that field does not have an associated list of values.) Some list of values fields 
have a corresponding LOV button (see Figure 1-3 below) that you will click to bring up a list of possible 
field entries. List of values fields that do NOT have a corresponding LOV button include “Pending 
Reason”, “Pending Comment”, “Denial Reason”, and “Reject Reason”. See below for information on how 
to use both types of LOV fields. 
 

Figure 1-3. LOV Button. 
 

How to use list of values fields that have LOV buttons: 
 

• Place the cursor in the field that corresponds to the LOV button. (The LOV button is to the right of the 
corresponding field.) 

• Click the LOV button. 
• Scroll to and/or click on the desired option.  
• Click OK. 
 

How to use list of values fields that do NOT have LOV buttons: 
 

• Double-click the field to launch the list of values dialog box. 
• Scroll to and/or click on the desired option. 
• Click OK. 
 
. NOTE: The “Find” button allows you to quickly find an item in a list of values without having to 
scroll through the whole list to get to it. For information on using the Find button in list of values 
dialog boxes, refer to the “ ‘Find’ Button Queries” subsection of Chapter 3.  
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Navigation 
Table 1-4 below explains the most common types of navigation you will use in the MAP-122 Adjustment 
system.  
 

Action Keyboard Key(s)  
To advance to the next field in a 
record 

• Tab  
• Enter 
• Ctrl + Tab 

To return to the previous field in a 
record 

• Shift + Tab 
• Ctrl + Shift + Tab 

To advance to the next record in a 
group  
 

↓  
(down arrow key) 

To return to the previous record in a 
group 

↑  
(up arrow key) 

Table 1-4. Navigation. 

Helpful Hints 
 
 Always read the short bits of information prefaced by “. NOTE”. These notes have been isolated from 
other text because of their general importance or their particular relevance to the topic at hand. 
 
 Always use the same naming convention (all caps or initial caps only) when adding new Adjustment 
requests. This is important because queries in MAP-122 are case-sensitive. That is, if you add an 
Adjustment request for a Recipient that you enter as JIM SMITH, you will not find that request if you 
query for Jim Smith. Everyone who uses MAP-122 should use the same style so that each person can find 
information entered by other users. Decide on all caps (i.e., JIM SMITH) or initial caps only (i.e., Jim 
Smith), and stick with it.  
 
 Never attempt to delete a record by deleting one field at a time. (Doing this does not actually delete the 
record, and it can result in significant problems with data and printed reports.)  

Logging On 
 
The MAP-122 Adjustment system should already be installed on your computer. Before you attempt to log 
on, ask your supervisor to provide the following pieces of information: 
 

3 Your username 
3 Your password 
3 The name of the database you will be using 
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To log on:   
 
• Double-click the MAP-122 icon on the Desktop of your PC. 
• In the Logon box (see Figure 1-5), click once in the “Username” field and type your username; then 

press Tab. 
• In the “Password” field, type your password; then press Tab. 
• In the “Database” field, type the name of the database; then click the Connect button (or press Enter).   
 

Figure 1-5.  Logon Box. 
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Chapter 2:  Primary Tasks 
 
This chapter addresses the main tasks associated with using the MAP-122 Adjustment system to process 
MAP-122 Adjustment requests.  
 
Primary tasks include the following: 
 

Entering a New Adjustment Request 
 
Updating an Adjustment Request 
 
Revising a Pending Adjustment Request 
 
Generating and Printing Letters 
 
Generating and Printing Envelopes 
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Entering a New Adjustment Request 
 
There are two categories of new Adjustment requests: those that pertain to Community-based Care (CBC) 
Recipients, and those that pertain to Recipients who reside in facilities. (A CBC Recipient is a Recipient 
who does not live in a facility.) 
 
Determine whether the new Adjustment request is for a CBC Recipient or a Recipient who lives in a 
facility; then proceed to the corresponding instructions below. 
 
. NOTE:  You must be consistent with the naming convention you choose, or you will not be able 
to effectively query for records in the database. For example, if you type Recipient names in ALL 
CAPS, then do that every time; or, if you type Recipient names with Initial Caps only, then stick 
with that. Consistency in this regard is essential because the query function in MAP-122 is case-
sensitive. (That is, if you enter a Recipient as SUE JONES and later perform a query for a Sue 
Jones, you will not find the record.) 
 
Entering a New Adjustment Request for a CBC Recipient 
 
These instructions pertain to only those requests that have never before been entered in the system.  
 
For information on accessing and updating existing Adjustment requests, see “Updating an Adjustment 
Request” or “Revising a Pending Adjustment Request” later in this chapter.  
 
Log on and do the following to enter a new Adjustment request for a CBC Recipient: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1). 
• Click the Maintenance menu. 
• Click the Community-based Care option to select it. 
• In the “First Name” field, type the Recipient’s first name; then press Enter. 
• In the “Last Name” field, type the Recipient’s last name; then press Enter. 
• In the “Recipient ID” field, type the Recipient’s Medicaid number; then press Enter. 
• In the “Home Address” field, type the Recipient’s street address; then press Enter. 
• In the “Address 2” field, type the Recipient’s apartment or other number (if applicable); then press 

Enter. 
• In the “City” field, type the Recipient’s city of residence; then press Enter. 
• In the “State” field, type the Recipient’s state of residence; then press Enter. 
• In the “Zip Code” field, type the Recipient’s zip code; then press Enter.  
• Click the “Service” field drop-down arrow and click the type of service received. 
• Click in the long blank field to the right of the “Service” field, and type a description of the service 

rendered; then press Enter. This line will appear in any letters that you generate, so be sure to be clear 
and concise in what you write. 

• In the “Cost” field, type the cost in dollars and cents. (You do not need to include the “$” symbol.) 
• Click in the “Salutation” field and type the way the Recipient should be addressed in any written 

correspondence. For example, if the Recipient’s name is Mr. Jerry Heinz, then you would type “Mr. 
Heinz” in the “Salutation” field.  

• Click the “Map Type” field drop-down arrow and click the appropriate Map type to select it. 
• Look at the “Destination” radio button options. Choose “Recipient” or “DSS” depending on where you 

want the reject letter to go in the event that the request should be rejected. (This destination option 
pertains only to reject letters.) For information on generating and printing letters, see the “Generating 
and Printing Letters” section later in this chapter. 

• Ignore the “Revised” checkbox; that is for existing Adjustments. 
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• Click the DSS button and click on the desired DSS; then click OK. (To find the DSS name quickly, 
perform a “Find” Button Query. For information on performing a “Find” Button Query, see Chapter 3.) 

• Click in the “Eligibility Worker” field and type the name of the eligibility worker; then press Enter.  
• In the “POA” field, type the name of the person who has Power of Attorney (if applicable); then press 

Enter. 
• In the “Date Received” field, type the date the Adjustment request was received; then press Enter. 

(Pressing Enter will advance the cursor to the “Date Mailed” field and populate that field.) 
• Ignore the Pending Dates button and fields; those are for existing Adjustment requests. 
• See one of the following based on the Map type you chose for the “Map Type” field:  
 
 

If the Map Type is “Approved”: 
 
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Pending”: 
 
• Double-click in the first “Pend” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK.  
• If there is more than one Pending reason, double-click in the second “Pend” field and repeat the 

process. Use the third “Pend” field as needed.  
• (If there is an associated Pending comment, skip the next two bulleted steps and proceed to the next 

sub-section called, “If there is a Pending comment”. If there is NOT an associated Pending comment, 
proceed to the bullet item directly below this one.) 

• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If there is a Pending comment: 
 
• Double-click in the first “Pend Comments” field to launch the list of values. 
• Scroll to and click on the desired comment. 
• Click OK. 
• If there is more than one Pending comment, double-click the second “Pend Comments” field and 

repeat the process. Use the third “Pend Comments” field as needed.  
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Rejected”: 
 

• Double-click in the first “Reject” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK. 
• If there is more than one Reject reason, double-click in the second “Reject” field and repeat the 

process. Use the third “Reject” field as needed.  
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Denied”: 
 
• Double-click in the first “Denial” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK. 
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• If there is more than one Denial reason, double-click in the second “Denial” field and repeat the 
process. Use the third “Denial” field as needed.  

• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
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Entering a New Adjustment Request for a Recipient Who Lives in a Facility 
 
These instructions pertain to only those requests that have never before been entered in the system.  
 
For information on accessing and updating existing Adjustment requests, see “Updating an Adjustment 
Request” or “Revising a Pending Adjustment Request” later in this chapter.  
 
Log on and do the following to enter a new Adjustment request for a Recipient who resides in a facility: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1). 
• Type the Recipient’s first name in the “First Name” field; then press Enter. 
• Type the Recipient’s last name in the “Last Name” field; then press Enter. 
• Type the Recipient’s 12-digit Medicaid number in the “Medicaid Number” field; then press Enter. 

Then proceed to the next bullet item below. OR, if you do not know the Medicaid number and you are 
dealing with a Recipient who has one or more existing Adjustments, click the Medicaid button. 

 
If you clicked the Medicaid button: 
 
- Scroll to the desired name. (To find the name quickly, perform a “Find” Button Query. For 

information on performing a “Find” Button Query, see Chapter 3.) 
- Make a note of the Recipient’s Medicaid number. (Do NOT select the Recipient’s name in the 

list.) 
- Click Cancel. (Do NOT click OK. See . NOTE below.) 
- Type the Medicaid number in the “Medicaid Number” field; then press Enter. 
- (Proceed to the next bullet item below.) 

 
. NOTE:  You cannot select the Recipient’s name using the Medicaid button if you are adding a 
NEW Adjustment for that Recipient. If you select his or her name in the list, you will bring up an 
existing Adjustment for that Recipient.  
 
• Click the Facility button. 
• Scroll to and click on the desired facility name; then click OK. (To find the name quickly, perform a 

“Find” Button Query. For information on performing a “Find” Button Query, see Chapter 3.) 
• Click in the “Facility Address” field. This will automatically populate the facility address fields.  
• Click the “Map Type” field drop-down arrow and click the desired Map type to select it. 
• Look at the “Destination” radio button options. Choose “Facility” or “DSS” depending on where you 

want the reject letter to go in the event that the request should be rejected. (This destination option 
pertains only to reject letters.) For information on generating and printing letters, see the “Generating 
and Printing Letters” section later in this chapter. 

• Click the “Service” field drop-down arrow and click the desired service to select it. 
• Click in the blank field to the right of the “Service” field, and type a description of the service. 

(Whatever you type here will show up in letters, so be clear and concise.) 
• Click in the “Cost” field and type the cost in dollars and cents; then press Enter. (You do not need to 

type the “$” symbol.) 
• In the “Salutation” field, type the way in which the Recipient should be addressed in any 

correspondence; then press Enter. (For example, if the Recipient’s name is Mr. Joe Barnes, you will 
want to type “Mr. Barnes” in the “Salutation” field.)  

• In the “Point of Contact” field, type the name of the contact person at the facility you indicated earlier; 
then press Enter. 

• In the “Eligibility Worker” field, type the name of the eligibility worker at the facility you indicated 
earlier; then press Enter. 

• With the cursor in the “Dept of Social Service” field, click the DSS button to the right of the field.  
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• Click a DSS to select it; then click OK. (To find the desired DSS more quickly, perform a “Find” 
Button Query. For information on performing a “Find” Button Query, see Chapter 3.) 

• Click in the “POA” field and type the name of the Power of Attorney (if applicable); then press Enter. 
• In the “Date Received” field, type the date on which the adjustment was received; then press Enter. 
• With the cursor in the “Date Mailed” field, press Enter again. This will cause the “Date Mailed” field 

to be populated with the last date of the current month.  
• Ignore the “Pending Dates” fields; those do not apply to new Adjustments.  
• Ignore the “Revised Adjustment” checkbox; that does not apply to new Adjustments. 
• See one of the following based on the Map type you chose for the “Map Type” field:  
 

If the Map Type is “Approved”: 
 
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Pending”: 
 
• Double-click in the first “Pend” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK.  
• If there is more than one Pending reason, double-click in the second “Pend” field and repeat the 

process. Use the third “Pend” field as needed.  
• (If there is an associated Pending comment, skip the next two bulleted steps and proceed to the next 

sub-section called, “If there is a Pending comment”. If there is NOT an associated Pending comment, 
proceed to the bullet item directly below this one.) 

• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If there is a Pending comment: 
 
• Double-click in the first “Pend Comments” field to launch the list of values. 
• Scroll to and click on the desired comment. 
• Click OK. 
• If there is more than one Pending comment, double-click the second “Pend Comments” field and 

repeat the process. Use the third “Pend Comments” field as needed.  
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Rejected”: 
 

• Double-click in the first “Reject” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK. 
• If there is more than one Reject reason, double-click in the second “Reject” field and repeat the 

process. Use the third “Reject” field as needed.  
• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

If the Map Type is “Denied”: 
 
• Double-click in the first “Denial” field to launch the list of values. 
• Scroll to and click on the desired reason. 
• Click OK. 
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• If there is more than one Denial reason, double-click in the second “Denial” field and repeat the 
process. Use the third “Denial” field as needed.  

• Click the “Insert” radio button at the bottom of the screen.  
• Click OK on the pop-up box telling you that you have added an Adjustment. 
 

Figure 2-1. Main Application Screen. 
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Updating an Adjustment Request 
 
You may occasionally need to “revisit” an existing Adjustment request to add or change information 
associated with it. You may, for instance, need to add the name of someone who has been assigned power 
of attorney for a Recipient; or, you may need to change the name of an eligibility worker associated with a 
particular Adjustment.  
 
As with new Adjustment requests, you must determine whether you want to update a CBC Adjustment 
request or an Adjustment request for a Recipient who resides in a facility. Follow those instructions below 
that correspond to the type of Adjustment request you want to update.  
 
. NOTE:  If your update pertains to revising the status of a pending Adjustment, see the section 
titled, “Revising a Pending Adjustment Request” later in this chapter. 
 
Updating a CBC Adjustment Request 
 
Log on and do the following to update an Adjustment request for a Community-based Care Recipient: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• Click the Maintenance menu. 
• Click the Community-based Care option to select it. 
• Do a query to bring up the desired Adjustment. (For information on performing queries, see Chapter 

3.) 
• Make the desired changes to the Adjustment. 
• Click the “Update” radio button at the bottom of the screen. 
• Click the File menu and choose Clear Record to clear the screen. 
 
Updating an Adjustment Request for a Recipient Who Lives in a Facility 
 
Log on and do the following to update an existing Adjustment: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• Do a query on the “Last Name” or “Medicaid Number” field to bring up the desired Adjustment. (For 

information on performing queries, see Chapter 3.) OR, do the following to bring up the desired 
Adjustment: Click the Medicaid button, and then click on the desired Recipient/Adjustment and click 
OK. Note that one Recipient may have multiple Adjustments, so you should take care to choose the 
correct one before clicking OK. 

• Make the desired changes to the Adjustment. 
• Click the “Update” radio button at the bottom of the screen. 
• Click the File menu and choose Clear Record to clear the screen. 
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Revising a Pending Adjustment Request 
 
. NOTE:  Review the “Performing Queries” section of Chapter 3 before proceeding with this 
section. 
 
An Adjustment request in “Pending” status will eventually be accepted or denied on the basis of additional 
information that is received and reviewed by an analyst in the Department of Medical Assistance Services. 
 
As with updating Adjustment requests, you must determine whether you want to revise a pending CBC 
Adjustment request or revise a pending request for a Recipient who resides in a facility. Follow the 
instructions below that correspond to the type of pending Adjustment request you want to revise.  
 
Revising a Pending CBC Adjustment Request 
 
Log on and do the following to revise a pending Adjustment request for a Community-based Care 
Recipient: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• Click the Maintenance menu. 
• Click the Community-based Care option to select it. 
• Do a query to bring up the desired pending Adjustment. (For information on performing queries, see 

Chapter 3.) 
• Click the “Map Type” field drop-down arrow and click Accepted or Denied as appropriate. 
• Click in the “Revised” checkbox to indicate that this Adjustment was revised. 
• Click the Pending Dates button. (Doing this will automatically populate the first “Pending Dates” field 

with the date on which the initial pending Adjustment was entered into the system.) 
• Proceed to one of the following on the basis of the revised Map Type (Approved or Denied):  
 

If the revised Map Type is Approved:  
 
• Click the “Update” radio button at the bottom of the screen.  
• Click the File menu and choose Clear Record to clear the screen. 
 

If the revised Map Type is Denied: 
 
• Double-click in the first “Denial” field to launch the list of values. 
• Scroll to and click on the desired denial reason. 
• Click OK. 
• If there is more than one Denial reason, double-click in the second “Denial” field and repeat the 

process. Use the third “Denial” field as needed.  
• Click the “Update” radio button at the bottom of the screen.  
• Click the File menu and choose Clear Record to clear the screen. 
 
Revising a Pending Adjustment Request for a Recipient Who Lives in a Facility 
 
Log on and do the following to revise the status of an existing Adjustment request: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• Do a query on the “Last Name” or “Medicaid Number” field to bring up the desired pending 

Adjustment. For information on performing queries, see Chapter 3. OR, do the following to bring up 
the desired Adjustment: Click the Medicaid button, and then click on the desired Recipient/Adjustment 
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and click OK. Note that one Recipient may have multiple Adjustments, so you should take care to 
choose the correct one before clicking OK. 

• Click the “Map Type” field drop-down arrow and click Accepted or Denied as appropriate. 
• Click in the “Revised Adjustment” checkbox to indicate that this Adjustment was revised. 
• Click the Pending Dates button. (Doing this will automatically populate the first “Pending Dates” field 

with the date on which the initial pending Adjustment was entered into the system.) 
• Proceed to one of the following on the basis of the revised Map Type (Approved or Denied):  
 

If the revised Map Type is Approved:  
 
• Click the “Update” radio button at the bottom of the screen.  
• Click the File menu and choose Clear Record to clear the screen. 
 

If the revised Map Type is Denied: 
 
• Double-click in the first “Denial” field to launch the list of values. 
• Scroll to and click on the desired denial reason. 
• Click OK. 
• If there is more than one Denial reason, double-click in the second “Denial” field and repeat the 

process. Use the third “Denial” field as needed.  
• Click the “Update” radio button at the bottom of the screen.  
• Click the File menu and choose Clear Record to clear the screen. 
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Generating and Printing Letters 
The MAP-122 Adjustment system allows you to generate and print letters for the various individuals who 
need to be informed of the status of an Adjustment request. These individuals include Recipients who live 
at nursing facilities, DSS eligibility workers, and Community-based Care (CBC) Recipients.  
 
You can print letters in batches, or you can print them individually by Medicaid number or individually by 
the date the request was received. (This date is indicated in the “Received Date” field on the main form.) 
 
Log on and do the following to generate and print any letter(s): 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• At the bottom of the main application screen, click the “Letters” radio button to launch the Map-122 

Adjustment Letters box (see Figure 2-2).  

     Figure 2-2. Map-122 Adjustment Letters Box.  
 
• On the Map-122 Adjustment Letters box, click the radio button beside the type of letter you would like 

to generate. (To see who each letter goes to, see Table 2-3 below.) 
• Click the Run Letter button to launch the letter parameters pop-up box. 
• Proceed to one of the following on the basis of whether you want to generate and print a batch of 

letters for a month-end, a single letter for (or in reference to) a specific Recipient, or all letters for 
Adjustment requests received on a specific date. 

See Table 2-3 below to see 
who will receive each type of 
letter shown here. 

Whether any given 
rejection letter goes 
to a Facility or a 
DSS is a function of 
which radio button 
you chose on the 
main form when 
you added the 
Adjustment. If you 
clicked the “Facility” 
radio button, the 
rejection letter will 
be addressed to the 
facility. If you 
clicked the “DSS” 
radio button, the 
rejection letter will 
go to the DSS. See 
Figure 2-1 to see 
the two radio 
buttons. 

Whether a given CBC 
rejection letter goes to a 
Recipient or to a DSS 
depends on the radio button 
you selected (“Recipient” or 
“DSS”) when you added the 
CBC Adjustment request. 
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Letter Who Receives Person(s) on CC List 
Approve Letters1 Recipient DSS Eligibility Worker 

POA 
Field Audit Manager 
Facility Point of Contact 

Deny Letters1 Recipient DSS Eligibility Worker 
POA 
Field Audit Manager 
Facility Point of Contact 

Pend Letters1 Facility Point of 
Contact 

Recipient 

Reject Letters to Facility Facility Point of 
Contact2 

Recipient 

Reject Letters to DSS DSS Eligibility 
Worker2 

Recipient 

Revised Letters (Approved) Recipient DSS Eligibility Worker 
POA 
Field Audit Manager 
Facility Point of Contact 

Revised Letters (Denied) Recipient DSS Eligibility Worker 
POA 
Field Audit Manager 
Facility Point of Contact 

Approval Letters for CBC Recipient DSS Eligibility Worker 
POA 
Field Audit Manager 

Deny Letters for CBC Recipient DSS Eligibility Worker 
POA 
Field Audit Manager 

Pend Letters for CBC DSS Eligibility 
Worker 

Recipient 

Reject Letters for CBC DSS Eligibility 
Worker or 
Recipient3 

Recipient 

Table 2-3. Who Receives Letters. 
 

1 For Recipients residing in a facility. 
 
2 Only if the corresponding radio button was chosen on the main Adjustment form. (See the note to the left 
of Figure 2-2 above.) 
 
3 Depending on the radio button you selected (“DSS” or “Recipient”) when you added the Community-
based Care Adjustment request, the rejection letter will go to either the DSS or the Recipient.  

 
 

To generate and print a batch of letters for month-end: 
 
• Click in the “Mailing Date” field and type the month-end date for which you would like to print the 

batch of letters (e.g., 01/31/2000). This will automatically print letters for requests that were received 
during the month for which you specify the month-ending date.  

• Click the Run Report button to generate the letters. 
• Click the Print button to print the letters. 
• Click OK on the Print dialog box. 
• Retrieve the letters at the printer. 
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To generate and print a letter for a specific Recipient: 
 

• Click in the “Medicaid Number” field, and type the Recipient’s Medicaid number; OR, click in the 
“Requested Date for Recipient” field and type the date on which the Recipient’s Adjustment request 
was received. (Doing the latter may generate more than one letter since there may have been more than 
one Adjustment request received for that date.) 

• Click the Run Report button to generate the letter. 
• Click the Print button to print the letter. OR, if additional letters were generated (for other Recipients 

with the same “Received” date), click the Next button in the Previewer until you come to the desired 
letter, and then click the Print button. On the Print dialog box, indicate which page to print. See Figure 
2-4 below for details. 

• Click OK on the Print dialog box. 
• Retrieve the letter at the printer. 
 

Figure 2-4. Print Dialog Box and Letter Previewer Page Indicator. 
 
 

To generate and print letters for all Adjustment requests received on a specific date: 
 
• Click in the “Requested Date for Recipient” field on the parameters pop-up box form and type the date 

for which you would like to generate the letters. Remember that the date you type here indicates the 
date on which the Adjustment requests were received. If you type 01/04/2000, for example, you will 
print letters for all Adjustment requests whose “Date Received” field shows 01/04/2000. 

• Click the Run Report button to generate the letters. 
• Click the Print button to print the letters. 
• Click OK on the Print dialog box. 
• Retrieve the letters at the printer. 

Look at the top of the Previewer to 
see the page number of the one 
letter you want to print in a group. 

Click the “Pages” radio button and 
type the page number in the “From” 
and “To” fields. Then click OK. 

Then… 
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Generating and Printing Envelopes 
The MAP-122 Adjustment system allows you to print corresponding envelopes for the letters you print. 
 
Log on and do the following to generate and print envelopes: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1). 
• Click the “Envelopes” radio button at the bottom of the screen to launch the envelope options pop-up 

box. 
• Click the radio button beside the type of envelope you want to generate (i.e., DSS, Facility, Resident, 

or Community-based Care envelopes). 
• Click the Run Envelopes button to launch the envelope parameters form. 
• On the envelope parameters form, click the “Viewing Type” drop-down arrow, and click Screen to 

select it.  
• Ignore the “Destination Name” field. It will automatically populate as needed. 
• Click in the “Mailing Date” field and type the same date you used to generate the letter(s) that will go 

in the envelope(s). For example, if you were printing envelopes for letters that have a mailing date of 
01/31/2000, you would type “01/31/2000” in this field.  

• Proceed to the directions below on the basis of whether you want to print a single letter for a single 
Recipient or print a group of month-end letters for a particular Adjustment status:   

 
If you want to print an envelope for a single Recipient (instead of a month-end group): 
 
- Type the Recipient’s Medicaid number in the “Medicaid Number” field. 
- Click the “Status” field drop-down arrow and choose the Adjustment status for which you printed 

the corresponding letter. 
- Click the Run Report button to generate the envelope(s).  
- Click the Print button on the envelope Previewer.  
- Click OK on the Print dialog box.  
- Go to the printer and retrieve your envelope (or manually feed it as needed). 

 
If you want to print envelopes for a month-end group of letters: 
 
- Ignore the “Medicaid Number” field since it is for single letters only. 
- Click the “Status” field drop-down arrow and choose the Adjustment status for which you printed 

the corresponding letters. 
- Click the Run Report button to generate the envelopes.  
- Click the Print button on the envelope Previewer.  
- Click OK on the Print dialog box.  
- Go to the printer and retrieve your envelopes (or manually feed them as needed). 
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Chapter 3:  Secondary Tasks 
 
This chapter addresses secondary tasks associated with using the MAP-122 Adjustment system to process 
MAP-122 Adjustment requests.  
 
Secondary tasks include the following: 
 

Performing Queries 
 

Generating and Printing Reports 
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Performing Queries 
Queries allow you to quickly pull up Adjustment request records that are already in the MAP-122 
Adjustment system. There are four main query techniques, and each of them is best used in the 
circumstances explained below. 
 
. NOTE:  Queries in MAP-122 are case-sensitive. This means that in performing a query you 
must use capital and lower-case letters in the way that you did when you added the record you 
are looking for. For example, if you added – in all caps – a Recipient named ANN CLARK, then 
you cannot find that record by querying for Ann Clark. You must query for ANN or CLARK in 
capital letters to find that record. Similarly, if you added the record as Ann Clark, you will not find 
it by querying for ANN or CLARK. 
 

Specific Query 
 
Perform a Specific Query when you know at least one whole piece of information that is in the record you 
want to find. This information could be a Recipient first or last name, a Medicaid Number, or any other 
piece of information that would be specific to a single Adjustment request. 
 
Log on and do the following to execute a Specific Query: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the Query menu. 
• Click the Enter option to select it. 
• Click in the field you want to query on, and type the known information. 
• Click the Query menu again. 
• Click Execute to execute the query. 
 
3 Specific Query Example: 
 
Richard wants to find an existing Adjustment request for a Recipient whose Social Security Number is 221-
45-1667. Richard should do the following 
 
- On the Main Interface screen, click Enter Adjustments Process button. 
- On the main application screen, click the Query menu. 
- Click the Enter option to select it. 
- Type 221-45-1667 in the “SSN” field.  
- Click the Query menu a second time. 
- Click Execute to execute the query.  
  

General Query 
 
Perform a General Query when you want to access a group of nonspecific record(s). This is a quick and 
easy way to populate the main application screen with a record. 
 
Log on and do the following to execute a General Query: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the Query menu. 
• Click the Enter option to select it. 
• Click the Query menu again. 
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• Click Execute to execute the query. 
• Use the First Record/Last Record and Next Record/Previous Record buttons (see Figure 3-1 below) to 

scroll through the records as desired. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
Figure 3-1. First, Previous, Next, and Last Record Buttons. 
 
3 General Query Example: 
 
Steve wants to populate the main application screen with a record so that he can see what kind of 
information goes in the “Map Type” field. Steve should do the following: 
 
- On the Main Interface screen, click Enter Adjustments Process button. 
- Click the Query menu. 
- Click the Enter option to select it. 
- Click the Query menu a second time. 
- Click Execute to execute the query.  
 

Wildcard Query 
 

Wildcard Queries allow you to query on partial or uncertain pieces of information by permitting substitute 
characters, or wildcards, to be used in place of those parts of the query data that you do not know. For 
example, Wildcard Queries are useful when you are uncertain of the spelling of a Recipient’s last name. 
Perform a wildcard query any time you know only a portion of a piece of information belonging to the 
Adjustment record you want to bring up. 
 

First 
Record 
button 

Last 
Record 
button 

Previous 
Record 
button 

Next 
Record 
button 
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Table 3-2 below explains the two MAP-122 Adjustment system wildcards and how to use them. 
 

Wild 
Character  

Explanation  How to Use  Examples of Usage Example of 
Results 

_   This wild 
character is an 
underscore ( _ ), 
not a dash.  
 
To create an 
underscore, 
press Shift + 
underline. (The 
underline key is 
above and to 
the right of “P” 
on your 
keyboard.)   
 
 

In the pattern, the 
underscore ( _ ) 
matches exactly one 
character in the 
search criteria.  
 
Use the underscore 
when you are sure 
of all characters in 
the search criterion 
except one. (See the 
example in the next 
column.) 

You want to find a 
record for a Recipient 
whose last name is 
spelled either Andersen 
or Anderson.  
 
To find this record, you 
would go to the main 
application screen, click 
the Query menu, and 
select Enter. Then you 
would  type the 
following into the “Last 
Name” field, click the 
Query menu, and click 
Execute to execute the 
query:   
 

Anders_n 
 
 

Anders_n would 
return all of the 
following:  
 
• Bart Andersen 
• Joe Andersen 
• Renee 

Anderson 
• Robert 

Anderson 
• Zelda Anderson 
 
(NOTE:  The above 
query results are 
examples only, and 
it is by coincidence 
if their names are 
present in the MAP-
122 Adjustment 
system database.) 

% This wild 
character is a 
percent sign.  
 
To create a 
percent sign, 
press Shift + 5. 

In the pattern, the 
percent sign (%) 
matches zero or 
more characters.  
 
Use the percent sign 
when you are not 
sure if your search 
criteria is missing 
any characters or 
when you know that 
your search criterion 
is missing at least 
one character and 
maybe more. (See 
the example in the 
next column.)  

You want to find an 
Adjustment request for 
which the first name of 
the Recipient source is 
Bill, Billy, or Billyboy.  
 
To find this Adjustment 
request, you would go to 
the main application 
screen, click the Query 
menu, and click Enter to 
select it. Then you would 
type the following into 
the “First Name” field, 
click the Query icon 
again, and click Execute 
to execute the query: 
 

Bill% 
 

Bill% would return 
all of the following: 
 
• Billie Hart 
• Bill Davidson 
• Bill Easterly 
• Bill Gates 
• Billy Stephens 
• Billyboy Sparks 
 
(NOTE:  The above 
query results are 
examples only, and 
it is by coincidence 
if their names are 
present in the MAP-
122 Adjustment 
system database.) 
 

Table 3-2. Wildcards. 
 

Log on and do the following to execute a Wildcard Query: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the Query menu. 
• Click Enter to select it.  
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• Type the query information/wildcard into the field on which you want to perform the query. (Refer to 
Table 3-2 above if you are not sure how to use a wildcard or if you are not sure which wildcard 
character to use in your query.) 

• Click the Query menu a second time. 
• Click Execute to execute the query.  
• Use the Next Record and Previous Record buttons (shown in Figure 3-1) to scroll through the query 

results for the desired record.  
 

3 Wildcard Query Example: 
 
Dave wants to find an Adjustment request for a Recipient whose last name is either McPherson or 
MacFearson. Dave should do the following: 
 
- On the main application screen, click the Query menu. 
- Click Enter to select it. 
- Type M%son in the “Last Name” field. 
- Click the Query menu again. 
- Click Execute to execute the query. 
- Use the Next Record and Previous Record buttons (shown in Figure 3-1) to scroll through the query 

results for the desired record if more than one record is returned.  
 

“Find” Button Query (on List of Values Forms) 
 
Use the “Find” Button Query when you have accessed a list of values and do not want to scroll through the 
entire list of possible values. For example, if you access a list of values for facilities to find the name of a 
facility that starts with the word “Virginia”, you will want to perform a “Find” Button Query to avoid 
scrolling all the way down the list to facility names starting with “V”. (Lists of values are alphabetized.) 
 
Read the “Wildcard Query” subsection of this chapter before proceeding with this subsection if you are not 
sure how to use wildcards in a search. 
 
. NOTE:  For additional information on lists of values, see the Chapter 1 subsection, “Lists of 
Values”. 
 
Do the following to perform a “Find” Button Query on a list of values box: 
 
• On the list of values box, type in the “Find” field what you know of the name or item you need in the 

list.  Be sure to type what you know before or after the “%” sign as appropriate. (See the “Wildcard 
Query” subsection of this chapter if you are unsure how to determine this.) 

• Click the “Find” button on the list of values box. 
• Click on the desired name or item. (You may still need to scroll to it.) 
• Click the OK button to select the desired name or item and dismiss the box. 
 
3 “Find” Button Query Example: 
 
Dana wants to select the Sussex DSS from the DSS list of values. She should do the following on the DSS 
list of values box: 
 
• Type “su” in front of the “%” sign in the “Find” field (see Figure 3-3). 
• Click the “Find” button. 
• Click the desired name. 
• Click the OK button to select the desired name and dismiss the list of values box. 
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Figure 3-3. Using the “Find” Field on the List of Values Box. 
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Generating and Printing Reports 
The MAP-122 Adjustment system allows you to print monthly and annual reports that summarize data 
associated with Adjustment requests. 
 
Monthly and annual reports reflect the information shown in Table 3-4 below. You can generate these 
reports for the status categories indicated. 
 

Report Available Status Categories Information on Report 
Monthly Reports* - Approved 

- Pending 
- Rejected 
- Denied 

 

- Recipient name 
- Facility 
- Service or item 
- Cost of service or item 
- Status of Adjustment (A, P, R, or D) 

Annual Reports* - Approved 
- Denied 

- Facility 
- Service or item 
- Total dollar amount by facility 
- Total dollar amount by service or item 
- Total dollar amount for report 

Annual Report for 
CBC 

- Approved 
- Denied 
 

- DSS name 
- Service or item 
- Total dollar amount by DSS 
- Total dollar amount by service or item 
- Total dollar amount for report 

Monthly Report for 
CBC 

- Approved 
- Denied 
- Pending 
- Rejected 

- Recipient name 
- DSS name 
- Service or item 
- Cost of service or item 
- Status of Adjustment (A, P, R, or D) 
- Total dollar amount for report 

Table 3-4. Report Information.  
 
*For Adjustment requests for Recipients who reside in facilities. 
 
Monthly Reports 
 
Monthly reports allow you to view monthly summaries of the information shown in Table 3-4 above for 
Adjustments from both CBC Recipients and Recipients who live in facilities.  
 
Determine whether you want to view monthly information for Adjustment requests that have CBC origins 
or facility origins; then proceed to the corresponding directions below. 
 
To view monthly reports for Adjustment requests from CBC Recipients: 
 
Log on and do the following to generate and print a monthly report of Adjustment requests from CBC 
Recipients: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the “Reports” radio button at the bottom of the main application screen to launch the report 
options box. 

• Click the “Monthly Report for CBC” radio button on the report options box. 
• Click the Run Reports button to launch the report parameters pop-up box. 
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• Click the “Viewing Type” drop-down arrow on the report parameters form and click Preview to select 
it. 

• Click in the “Mailing Date” field and type the mailing date for the desired month. This must be a 
month-ending date (e.g., 04/30/2000; 05/31/2000; etc.).  

• Click the “Status” drop-down arrow and click the desired status (A, P, R, or D). 
• Click the Run Report button. 
• Click Print on the report Previewer. 
 
To view monthly reports for Adjustment requests from Recipients who live in facilities: 
 
Log on and do the following to generate and print a monthly report of Adjustment requests from Recipients 
who live in facilities: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the “Reports” radio button at the bottom of the main application screen to launch the report 
options box. 

• Click the “Monthly Reports” radio button on the report options box. 
• Click the Run Reports button to launch the report parameters pop-up box. 
• Click the “Viewing Type” drop-down arrow on the report parameters form and click Preview to select 

it. 
• Click in the “Mailing Date” field and type the mailing date for the desired month. This must be a 

month-ending date (e.g., 04/30/2000; 05/31/2000; etc.).  
• Click the “Status” drop-down arrow and click the desired status (A, P, R, or D). 
• Click the Run Report button. 
• Click Print on the report Previewer. 
 
Annual Reports 
 
Annual reports display summaries of the information shown in Table 3-4 for Adjustment requests from 
CBC Recipients and Recipients who live in facilities.  
 
Determine whether you want to view annual information for Adjustment requests that have CBC origins or 
facility origins; then proceed to the corresponding directions below. 
 
To view an annual report for Adjustment requests from CBC Recipients: 
 
Log on and do the following to generate and print an annual report for Adjustment requests from CBC 
Recipients: 
 
•  On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the “Reports” radio button at the bottom of the main application screen to launch the report 
options box. 

• Click the “Annual Report for CBC” radio button on the report options box. 
• Click the Run Reports button to launch the report parameters pop-up box. 
• Click the “Viewing Type” drop-down arrow on the report parameters form and click Preview to select 

it. 
• Ignore the “Destination Name” field. It will populate automatically as needed. 
• Click in the “Start Date” field and type the date on which you want the annual report data to begin. 
• Click in the “End Date” field and type the year-ending date for the annual report. 
• Click the “Map Type” field drop-down arrow and click the desired status (A or D). 
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• Click the Run Report button. 
• Click Print on the report Previewer 
 
To view an annual report for Adjustment requests from Recipients who live in facilities: 
 
Log on and do the following to generate and print an annual report for Adjustment requests from Recipients 
who live in facilities: 
 
•  On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (see Figure 2-1 in 
Chapter 2). 

• Click the “Reports” radio button at the bottom of the main application screen to launch the report 
options box. 

• Click the “Annual Reports” radio button on the report options box. 
• Click the Run Reports button to launch the report parameters pop-up box. 
• Click the “Viewing Type” drop-down arrow on the report parameters form and click Preview to select 

it. 
• Ignore the “Destination Name” field. It will populate automatically as needed. 
• Click in the “Start Date” field and type the date on which you want the annual report data to begin. 
• Click in the “End Date” field and type the year-ending date for the annual report. 
• Click the “Map Type” field drop-down arrow and click the desired status (A or D). 
• Click the Run Report button. 
• Click Print on the report Previewer 
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Chapter 4:  Administrative Tasks 
 
This chapter addresses administrative tasks that must be completed before the MAP-122 Adjustment 
system can be used to record MAP-122 Adjustment requests. The completion of administrative tasks 
provides a “foundation” of database data that includes DSS addresses, facility addresses, and reasons for 
denials and rejections of Adjustment requests. The addition of this information to the database allows users 
to choose addresses and reasons from lists rather than type them over and over with each new Adjustment 
request. 
 
Administrative tasks include the following: 
 

Adding Reason Codes 
 
Adding Facility Information 
 
Updating Facility Information 
 
Adding DSS Information 
 
Updating DSS Information 

 
. NOTE: Each subsection indicates applicable user roles.  
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Adding Reason Codes 
 
Applicable User Roles  
Manager 
Administrator  

 
By adding reason codes to the MAP-122 database, you enable users to choose pending, denial, and reject 
reasons from easily accessible lists. This is a time-saver that prevents users from typing lengthy reason 
statements each time they use them. 
 
Log on and do the following to add reason codes to the MAP-122 Adjustment system: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1 in 
Chapter 2). 

• Click the Reasons menu. 
• Do one of the following based on the type of reason you want to add. 
 

To add a Pending reason(s): 
 

- Click the Pend option to select it. 
- On the Pending Reasons form, click the “Query” radio button. 
- Scroll down the list of existing reasons to see what code (left column) should be used next. (For 

example, if p92 is the last one, you should add p93.) 
- When you know what code number to add, click the “New Record” radio button. 
- In the Codes column, type the code number; then press Enter. 
- In the Reasons column, type the pending reason. (Be as grammatically correct as possible, since this 

will appear on letters of correspondence that you generate.) 
- Click the “Save” radio button. 
- If you want to add another reason, click the “New Record” radio button and repeat the same steps; OR, 

click the “Exit” radio button to exit the Pending Reasons form. 
 

To add a Denial reason(s): 
 

- Click the Deny option to select it. 
- On the Denial Reasons form, click the “Query” radio button. 
- Scroll down the list of existing reasons to see what code (left column) should be used next. (For 

example, if d42 is the last one, you should add d43.) 
- When you know what code number to add, click the “New Record” radio button. 
- In the Codes column, type the code number; then press Enter. 
- In the Reasons column, type the denial reason. (Be as grammatically correct as possible, since this will 

appear on letters of correspondence that you generate.) 
- Click the “Save” radio button. 
- If you want to add another reason, click the “New Record” radio button and repeat the same steps; OR, 

click the “Exit” radio button to exit the Denial Reasons form. 
 

To add a Reject reason(s): 
 

- Click the Reject option to select it. 
- On the Reject Reasons form, click the “Query” radio button. 
- Scroll down the list of existing reasons to see what code (left column) should be used next. (For 

example, if r8 is the last one, you should add r9.) 
- When you know what code number to add, click the “New Record” radio button. 
- In the Codes column, type the code number; then press Enter. 

 4-2 



MAP-122 Adjustment System User Manual  Chapter 4:  Administrative Tasks 

- In the Reasons column, type the rejection reason. (Be as grammatically correct as possible, since this 
will appear on letters of correspondence that you generate.) 

- Click the “Save” radio button. 
- If you want to add another reason, click the “New Record” radio button and repeat the same steps; OR, 

click the “Exit” radio button to exit the Reject Reasons form. 

Adding Facility Information 
  
Applicable User Roles  
Manager 

 
By adding facility address information to the database, you enable users to populate numerous facility 
address fields automatically just by choosing a facility name from a list. This is a time-saver because it 
prevents users from having to type information for every address field every time they indicate a 
Recipient’s facility. Additionally, you enable users to generate letters and envelopes that contain facility 
address information.  
 
Log on and do the following to add facility information to the MAP-122 Adjustment system: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1 in 
Chapter 2). 

• Click the Maintenance menu. 
• Click Facility to select it. 
• Ignore the “Facility Code” field. (The system will automatically populate it with a number after you 

insert the new facility.) 
• Click in the “Facility Name” field and type the name of the facility; then press Enter. 
• Type the street address in the first “Facility Address” field; then press Enter. 
• Type any suite or unit numbers in the second “Facility Address field” (as applicable); then press 

Enter. 
• Type the facility’s city in the “City” field; then press Enter. 
• Type the facility’s state in the “State” field; then press Enter. 
• Type the facility’s zip code in the “Zip Code” field; then press Enter. 
• Type the facility’s phone number in the “Phone Number” field; then press Enter.  
• Type the facility’s fax number in the “Fax Number” field. 
• Click the “Insert” radio button. 
• If you want to add another facility, click the “Clear” radio button and repeat the previous steps; OR, 

click the “Exit” radio button to dismiss the Facility form. 

Updating Facility Information 
 
Applicable User Roles  
Manager 

 
It may occasionally be necessary to update the name, address, phone number, or fax number of a nursing 
facility. 
 
Log on and do the following to update nursing facility information: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1 in 
Chapter 2). 

• Click the Maintenance menu. 
• Click Facility to select it. 
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• Perform a query to bring up the facility whose information you would like to update. (For information 
on how to do a query, see the “Performing Queries” section of Chapter 3.) Note that when you do 
queries using the “Query” radio button (instead of a Query menu), you click the “Query” radio button 
twice: once to initiate the query, a second time to execute it.  

• Make the desired change(s) to the facility information. 
• Click the “Update” radio button.  
• Click the “Exit” radio button to dismiss the Facility form.  

Adding DSS Information 
 
Applicable User Roles  
Manager 

 
By adding DSS address information to the database, you enable users to generate letters and envelopes that 
contain DSS address information.  
 
Log on and do the following to add DSS information to the MAP-122 Adjustment system: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1 in 
Chapter 2). 

• Click the Maintenance menu. 
• Click DSS to select it. 
• Type the DSS’s code in the “DSS Code” field. (Each DSS has an assigned code. If you are unsure of 

the code for the DSS you are adding, inquire with your supervisor.) 
• Click in the “DSS” field and type the name of the DSS you are adding; then press Enter. 
• Type the DSS street address in the “Address 1” field; then press Enter. 
• Type any suite or office numbers (as applicable) in the “Address 2” field; then press Enter. 
• Type the department’s city in the “City” field; then press Enter. 
• Type the department’s state in the “State” field; then press Enter. 
• Type the department’s zip code in the “Zip Code” field. 
• Click the “Insert” radio button. 
• Click the “Exit” radio button to dismiss the DSS form. 

Updating DSS Information 
 
Applicable User Roles  
Manager 

 
It may occasionally be necessary to update the name or address of a department of social services. 
 
Log on and do the following to update DSS information: 
 
• On the Main Interface screen, click the Enter Adjustments Process button. If you have already done 

this, then you are already on the main application screen where you need to be (shown in Figure 2-1 in 
Chapter 2). 

• Click the Maintenance menu. 
• Click DSS to select it. 
• Perform a query to bring up the DSS whose information you would like to update. (For information on 

how to do a query, see the “Performing Queries” section of Chapter 3.) 
• Make the desired change(s) to the DSS information. 
• Click the “Update” radio button.  
• Click the Exit button to return to the main application screen.  
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Appendix:  Menus & Menu Options 
 
This appendix lists and explains menus and menu options in the MAP-122 Adjustment system.  
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The following menus and menu options appear throughout the MAP-122 Adjustment system. 
 
File 
 
The File menu contains standard Windows options and other options that perform basic file manipulation.   
 

Cut 
 

Cuts selected text. 
 

Copy 
 

Copies selected text to the Windows clipboard for pasting to another location. 
 
Paste 
 

Pastes text that has been copied to the Windows clipboard to the field where the cursor is located.  
 
Clear Field 

 
Clears the field where the cursor is located.  

 
Clear Record 

 
Clears the screen of the current record.  

 
Clear Date(s) 
 

Clears date(s) in the “Pending Dates” field(s). 
 
Duplicate Item 
 

Copies the previous record’s value for the current field. 
 
Duplicate Record 
 

Duplicates all values from the previous Recipient or Case record as determined by the location of the 
cursor. You can duplicate a record’s information into a new record only.  
 
Query 
 
The Query menu provides options that allow you to query for existing Adjustment request records and 
other information. See the “Performing Queries” section of Chapter 3 for information on how to perform a 
query. 
 

Enter 
 
Puts the MAP-122 Adjustment system in query mode. 

 
Execute 
 

Executes the current query.  
 

Abort 
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Cancels the current query. 
Action 
 
The Action menu provides major functionality for Adjustment records.  
 

Insert Adjustment 
 
Inserts a new Adjustment as a record in the database. 

 
Update Adjustment 

 
Updates an existing Adjustment record in the database to include newly made changes. 
 

Delete Adjustment 
 
Deletes the current Adjustment from the database.  

 
Maintenance 
 
The Maintenance menu allows managers to add foundational information about nursing facilities and 
departments of social services.  
 

Facility 
 

Brings up the form for adding and/or updating nursing facility address, phone, and fax information. 
 
DSS 
 

Brings up the form for adding and/or updating department of social service address and phone information. 
 

Community-based care 
 

Brings up the form for adding an Adjustment request from a Recipient who does NOT reside in a facility.  
 
Administration 
 
The Administration menu allows you to generate and print letters, reports, and envelopes.  
 

Letters 
 

Brings up the Adjustment letters option box where you can indicate the type of letter you would like to 
generate.   

 
Reports 

 
Brings up the Adjustment reports option box where you can indicate whether you want to generate a 
monthly or annual report.  

 
Envelopes 
 

Brings up the Adjustment envelopes option box where you can indicate whether you want to generate DSS, 
facility, private residence, or Community-based Care envelopes.  
 
Reasons 
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The Reasons menu allows administrators and managers to add reasons that correspond to the Adjustment 
request statuses Pend, Reject, and Deny. 
 

 
Pend 
 

Brings up the form for adding Pend reasons to the database. 
 
Deny 
 

Brings up the form for adding Deny reasons to the database.  
 

Reject 
 

Brings up the form for adding Reject reasons to the database.  
 

Window 
 
The Window menu offers functionality for manipulating the display of Windows on the screen. 
 

Cascade 
 

The Cascade option creates overlapping layers out of the open Windows so that a portion of each Window 
is visible.  
 

Tile 
 

The Tile option creates side-by-side “tiles” out of the open Windows.  
 

Arrange Icons 
 

The Arrange Icons option is a standard Windows option that arranges Desktop icons. This option does not 
apply to the MAP-122 Adjustment system.  
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